smarttech.com/docfeedback/170814

SMART Board® 8000i-G5-SMP series

interactive flat panels

ADMINISTRATOR’S GUIDE
FOR MODELS SBID8055i-G5-SMP, SBID8065i-G5-SMP, SBID8065i-G5-SMP-V2 AND SBID8075i-G5-SMP



http://www.smarttech.com/docfeedback/170814

Product registration
If you register your SMART product, we’ll notify you of new features and software upgrades.
Register online at smarttech.com/registration.

Keep the following information available in case you need to contact SMART Support.

Serial number:

Date of purchase:

COEIT, 7 T AMERENISE T, JORBELFERECHERT 2 LEREEDISRITIENHY ET. ZOBGITIIENE N EY LR EHT 5 X
JERENDZLBDHY ET,
VCCI-A

Licenses

The terms HDMI and HDMI High-Definition Multimedia Interface, and the HDMI logo are trademarks or registered trademarks of HDMI Licensing LLC in the United
States and other countries.

Trademark notice

SMART Board, SMART kapp iQ, SMART Ink, SMART Meeting Pro, DVIiT, Pen ID, smarttech, the SMART logo and all SMART taglines are trademarks or registered
trademarks of SMART Technologies ULCinthe U.S. and/or other countries. All third-party product and company names may be trademarks of their respective
owners.

Copyright notice

© 2015-2016 SMART Technologies ULC. All rights reserved. No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system
or translated into any language in any form by any means without the prior written consent of SMART Technologies ULC. Information in this manual is subject to
change without notice and does notrepresenta commitment on the part of SMART.

This product and/or use thereofis covered by one or more of the following U.S. patents:
www.smarttech.com/patents
09/2016

smarttech.com/kb/170814


http://www.smarttech.com/kb/170814
http://www.smarttech.com/registration
http://www.smarttech.com/patents

Important information

A WARNING

« Failure to follow the installation instructions shipped with the interactive flat panel could
result in injury and product damage which may not be covered by the warranty.

« Do notopen ordisassemble the interactive flat panel. You risk electrical shock from the high
voltage inside the casing. Opening the casing also voids the warranty.

« Do not stand (or allow children to stand) on a chair to touch the surface of the interactive flat
panel. Rather, mount the product at the appropriate height.

« To reduce the risk of fire or electric shock, do not expose the interactive flat panel to rain or
moisture.

« Ifthe interactive flat panel requires replacement parts, make sure the service technician
uses replacement parts specified by SMART Technologies or parts with the same
characteristics as the original.

o Ensure that any cables that cross the floor to the interactive flat panel are properly bundled
and marked to avoid a trip hazard.

« Do notinsert objects inside the cabinet ventilation holes, because they could touch
dangerous voltage points and cause electric shock, fire or product damage which may not
be covered by the warranty.

« Do not place heavy objects on the power cable. Damage to the cable could cause shock,
fire or product damage which may not be covered by the warranty.

« Use only extension cords and outlets that can fully accommodate the interactive flat panel’s
polarized plug.

« Use the power cable provided with the interactive flat panel. If a power cable is not
supplied, contact your supplier. Use only power cables that match the AC voltage of the
power outlet and that comply with your country’s safety standards.

o Ifthe glassis broken, do not touch the liquid crystal. To prevent injury, handle glass
fragments with care when disposing of them.

« Do not move or mount the interactive flat panel by connecting rope or wire to its handles.
The interactive flat panel is heavy, and failure of the rope, wire or handle could lead to

injury.

smarttech.com/kb/170814
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« Use only VESA®-approved mounting hardware.

« Disconnect all of the interactive flat panel’s power cables from the wall outlet and seek
assistance from qualified service personnel if any of the following occur:

o The power cable orplug is damaged

o Liquid is spilled into the interactive flat panel
o Objects fall into the interactive flat panel

o The interactive flat panel is dropped

o Structural damage, such as cracking, occurs

o The interactive flat panel behaves unexpectedly when you follow operating

instructions

« The pens on this product use an adhesive containing nonylphenol ethoxylate, a candidate

substance of very high concern under the EU REACH Regulation (EC) 1907/2006.

Uil o3 e (5 5ma3 A0a 5ol ziial) Ba 353 5 sl 228V p2200s
A8 8085 y5ba L) 5% Ol Aad abale (b 5 oD 5l
REACH 23 5 2 5,55¥) sas™ (EC) 1907/2006.

Las plumas de este producto utilizan un adhesivo que
contiene etoxilato de nonilfenol, una sustancia candidata
de muy alto riesgo segln el Reglamento REACH de la UE
(CE)1907/2006.

Pera na tomto produktu vyuzivaji lepidlo obsahujici
nonylfenol ethoxylat, coz je dle nafizeni (ES) REACH
1907/2006 latka vzbuzujicimimoradné obavy.

Pennene pa dette produkt anvender et klsebemiddel der
indeholder nonylphenolethoxylat, et stof der er seerligt
problematiske under EU REACH forordningen (EF)
1907/2006.

Die Stifte dieses Produkts verwenden einen Klebstoff mit
Nonylphenolethoxylat, einem Stoff der nach Artikel 59
der Verordnung (EG) Nr.1907/2006 (REACH) auf der
Liste der Stoffe mit einem betrachtlichen Risiko steht.

O1éveg 0V TOV TOL TTPOTIOVTOG YPNOLHOTIOOVV pia
KOAMNTIKN ovcia Tov epiéyet o o&vitm pévn
evveblAO® VO, Pl TTOY N Lo 0V Gia TTOV TTpoKaAel
ToAD peyaAn avnovyio oV o va pe Tov Kavoviepd
REACH tn¢ EE (EK) 1907/2006.

Los rotuladores de este producto emplean un adhesivo
que contiene etoxilato de nonilfenol, una sustancia
candidata de gran preocupacién segun la regulacién
REACH de la UE (CE) 1907/2006.

0l MZ2 B2 EU REACH Regulation (EC)
1907/200601 2ol NPAE LR FEE2=2 & &

CEH= HSAICO0IEI SRE EXME AHEEU
Ch.

)41

eTTTE g

Voor de stiften in dit product wordt gebruik gemaakt van
een kleefstof met nonylfenolethoxylaat, een
zeerzorgwekkende stof op dekandidaatslijst volgens de
Europese REACH-richtlijn (EG) 1907/2006.

Pennene som felger med dette produktet bruker et
klebestoff som inneholdernonylfenoloksetylat, et stoff
det er ytret stor bekymring for iEU REACH Regulation
(EC) 1907/2006.

Piéra na tym produkcie uzywaja kleju zawierajacego
etoksylan nonylofenolu, substancje z listy kandydackiej
wzbudzajgcg duze obawy na mocy unijnego
Rozporzgdzenia REACH (WE) 1907/2006.

As canetas neste produto usam um adesivo contendo
nonilfenol etoxilado, uma substancia candidata que
suscita elevada preocupacdo no &mbito do
regulamento EU REACH (EC) 1907/2006.

B numymux pyukax 1a HHOTO U3/1€ 1Sl UCIIOJIb3Ye TCs
KIIe i, co/ie prKa Uit OKCUITHINPOB A HHBI I HOHUII( e HOJT
—KaHJIHJaTHA BKIIOYEHUE B CIHCKU 0CO0O OI1a CHBIX
BEIIECTB B cCOOTBETCTBUY C Pernmame ntom EC
OTHOCHUTEJIbHO IPAaBUJI PETUCTPALIUH, OLIC HKH,
CAHKIMOHUPOBAHUS M OTPAHUYEHUS HCIIOJIb30BaHUS
xumu4e ckux Beuie cts (REACH) 1907/2006.
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Taman tuotteen kynissa on limaa, joka sisaltaa
nonyylifenolietoksylaattia, joka on erityinen huolenaihe
EU REACH-asetuksen (EY) 1907/2006 mukaan.

Les crayons de ce produit utilisent un adhésif contenant
des éthoxylates de nonylphénol, substance
extrémement préoccupante en vertu du réglement
REACH de I'UE (CE) 1907/2006.

Ezen a terméken a tollak egy nonil-fenol-etoxilatot
tartalmazo ragasztét hasznélnak.Ezaz anyag az
1907/2006/EK REACH-rendelet értelmében kiilonods
aggodalomra okot adé.

Le penne diquesto prodotto utilizzano un adesivo
contenente etossilato di nonilfenolo, una sostanza
candidata estremamente problematica aisensidel
regolamento REACH dell'UE (CE) 1907/2006.

COEGDORIZIE. EUDREACHFRA] (EC) No
1907/2006 CEH LN TWSEREMEEHTH D/
L7/ =TI X L— rEETEERINER
ShTWET,

Pisala na tem izdelku uporabljajo lepilo, ki vsebuje
nonilfenol etoksilat, ki se uvr§¢a med snovi, kimorda
vzbujajo zelo veliko skrb v skladu z Uredbo EU (ES)
1907/2006 REACH.

De inkluderade pennorna for denna produkt anvander
ett bindemedel som innehallernonylfenoletoxylat, som
ar foremal for bekymmer enligt EU REACH forordning
(EG)1907/2006.

Bu triindeki kalemler, AB REACH Y &netmeligi(EC)
1907/2006 uyarinca son derece endise uyandiran
madde adayi nonilfenol etoksilat iceren bir yapistiricyi
kullanmaktadir.

AP i BT 2 AR R 2 R IR T R R A L ik
(nonylphenol ethoxylate) , HEHERK % REACHYZE: HH
(EC) 1907/2006, Btk 2Rt 2 Gk 24 4 5
ZAEEA T Z —

AR i BT 2 SRR 2 R R T AR R A L ik
(nonylphenol ethoxylate), AR$EEKE REACH 7E:#i (EC)
1907/2006, B Ak 40 Ryhinsz B D) AL 524 42 B b 2 feide
Mz —.

CAUTION

« Before you clean the interactive flat panel’s screen, shut down or disconnect the computer.
Otherwise, you may scramble the desktop icons or inadvertently activate applications when
you wipe the screen.

« Avoid setting up and using the interactive flat panel in an area with excessive levels of dust,
humidity and smoke.

o Dust buildup on the camera windows and reflective tape will degrade touch performance.
SMART recommends that you inspect the camera windows and reflective tape for buildup
and clean weekly.

« Make sure an electrical socket is near the interactive flat panel and remains easily
accessible during use.

« The interactive flat panel should be used only with European TN and TT power distribution
systems.

It is not suitable for older, IT-type power distribution systems found in some European
countries. “This system (IT-type) is widely used isolated from earth, in some installations in
France, with impedance to earth, at 230/400V, and in Norway, with voltage limiter, neutral
not distributed, at 230V line-to-line.” (IEC 60950:1999)

Contact qualified personnel if you're uncertain of the type of power system available where
you're installing the interactive flat panel.

iii smarttech.com/kb/170814
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o The accessory slot’s maximum available poweris 60 W. The slot is not a limited power

source. To reduce the risk of fire, make sure that accessories connecting to the slot satisfy
the fire enclosure requirements of [IEC 60950-1.

You must connect the USB cable that came with the interactive flat panel to a computer that
has a USB compliant interface and that bears the USB logo. In addition, the USB source
computer must be compliant with CSA/UL/EN 60950 and bear the CE mark and CSA and/or
UL Mark(s) for CSA/UL 60950. This is for operating safety and to avoid damage to the
interactive flat panel.

IMPORTANT

The following are the maximum power requirements for the interactive flat panel (including
the power requirements for the accessory slot):

Model Power requirements

SBID8055i-G5-SMP 90V to 240V AC, 50 Hz to 60 Hz, 134 W
SBID8065i-G5-SMP 100V to 240V AC, 50 Hz to 60 Hz, 199 W
SBID8065i-G5-SMP-V2 100V to 240V AC, 50 Hz to 60 Hz, 189 W
SBID8075i-G5-SMP 100V to 240V AC, 50 Hzto 60 Hz, 315 W

For additional requirements and other information, refer to the interactive flat panel’s
specifications (see Resources for decision makers on page 10).

iv
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This chapterintroduces SMART Board® 8000i-G5-SMP series interactive flat panels and this guide.

About this guide

This guide explains how to set up and maintain a SMART Board 8000i-G5-SMP series interactive
flat panel. It includes the following information:

« How to mount the interactive flat panel
« How to connect power and devices

« How to set up the interactive flat panel

1 smarttech.com/kb/170814
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« How to maintain the interactive flat panel for years of use
« How to troubleshoot issues with the interactive flat panel

In addition, this guide includes information on the interactive flat panel’s remote management
support and on-screen display menu.

This guide is intended for individuals who install and maintain interactive flat panels in their
organizations. Other documentation and resources are available for individuals who use
interactive flat panels.

About the interactive flat panel
The SMART Board 8000i-G5-SMP series interactive flat panel features SMART’s proprietary DViT®
(Digital Vision Touch) technology on an LCD screen with e-LED backlight.

Models
Four models of SMART Board 8000i-G5-SMP series interactive flat panel are available:

« SMART Board 8055i-G5-SMP interactive flat panel (SBID8055i-G5-SMP)
« SMART Board 8065i-G5-SMP interactive flat panel (SBID8065i-G5-SMP)
o« SMART Board 8065i-G5-SMP-V2 interactive flat panel (SBID8065i-G5-SMP-V2)

« SMART Board 8075i-G5-SMP interactive flat panel (SBID8075i-G5-SMP)

Differences among these models are noted in this guide.

Specifications
Refer to the interactive flat panel’s specifications for detailed technical information, including
product dimensions and weights.

2 smarttech.com/kb/170814
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Features
The interactive flat panel includes the following features:

Feature Description

Touch support You can do everything on the interactive flat panel that you can do
at your computer—open and close applications, meet with others,
create new documents or edit existing ones, visit websites, play
and manipulate videos, and so on—by touching the
interactive flat panel’s surface.

You can use an array of gestures within applications, including
panning, scaling, rotating and zooming in and out.

The interactive flat panel’s support for at least four simultaneous
touches enables you and other users to interact with objects on the
screen at the same time.

Writing and drawing You can write over any application in digital ink using one of the
support supplied pens, and then erase the digital ink using your palm or the
eraser on the pen.
You and another writer can write or draw digital ink on the screen at
the same time. The Pen ID"™ feature enables you to assign different
ink appearances to each pen.

Audio support The interactive flat panel includes integrated speakers for
presenting audio from connected input sources.

SMART ka PP iQ The interactive flat panel is available with SMART kapp iQ™
functionality. You can share whiteboard sessions with others using
your mobile device. Others can contribute to the whiteboard
session from their computers or mobile devices.

3 smarttech.com/kb/170814
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Components
The interactive flat panel consists of the following components:

1
N |
2 3 2
3— —3
2 3 2
|
e G TCam——r) 5
: . :

No. Name More information
Pictured

1 Screen Page 5
2 Cameras Page 5
3 Reflective tape channel Page 5
4 Front control panel Page 6
5 Pen with eraser (x2) Page 7
6 Presence detection sensor Page 8
Not pictured

7 Speakers Page 8
8 Connector panel Page 17
10 USB receptacle Page 8
" Accessory slot Page 9

4 smarttech.com/kb/170814


http://www.smarttech.com/kb/170814

CHAPTER1
WELCOME

Screen
The screen sizes vary by model:

Model Diagonal Width Height Aspect ratio
SBID8055i-G5-SMP 541/2" (138.4 cm) 475/8" (121 cm) 26 3/4" (68 cm) 16:9
SBID8065i-G5-SMP 641/2" (163.9 cm) 561/4" (142.8 cm) 315/8"(80.4 cm) 16:9
SBID8065i-G5-SMP-V2 641/2" (163.9 cm) 561/4" (142.8 cm) 315/8"(80.4 cm) 16:9
SBID8075i-G5-SMP 75" (190.5 cm) 65" (165.2 cm) 385/8" (93 cm) 16:9

For information on cleaning the screen, see Cleaning the screen on page 33.

Cameras and reflective tape channel

Cameras in the corners of the screen track finger and pen positions across the display. The screen

is bordered by a channel that contains reflective tape.

For information on cleaning the camera windows and reflective tape, see Cleaning the camera

windows and reflective tape on page 33.

A CAUTION
o Keep the reflective tape dry.

« Do notremove ordamage the reflective tape.

—> IMPORTANT

« Do not attach adhesive notes or otheritems to the screen because they will interfere with

the cameras.

« Do not place anything in the reflective tape channel because it will interfere with the

cameras.
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Front control panel
The front control panel contains the Standby, Input Select, Mute and volume control buttons.

1 2 3 4 5
' |

> ] 8 & <L &+ ]

| -‘

1 Standby button'

2 Input Select button?
3 Mute button>

4 Volume decrease

5 Volume increase

—> IMPORTANT

If there is a film over the front control panel, remove it before using the front control panel.

In normal operation, all buttons are white.

The Standby button also functions as an indicator light:

Indicator light Status Troubleshooting

Solid white Normal operation [N/A]

TPress and hold to reset the interactive flat panel

2Change the input source to OPS/HDMI for the kapp iQ experience.
3Press and hold to freeze and unfreeze the screen (SMART Board 8065i-G5-SMP-V2 and 8075i-G5-SMP interactive flat panels
only)
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Indicator light Status

Off Not receiving power

Solid amber DPMS (power management)

mode

No USB connection from the
connected computer

Flashing amber

Slowly flashing SMART Board service not
white running on the connected
computer

Pens with erasers

Troubleshooting

Confirm the interactive flat panel’s power
cable is connected to the power outlet
(see page 19).

Flick the power switch to the ON (l)
position (see page 23).

Press the Standby button d to exit
DPMS mode.
Connect an input source.

Verify the connections to the room
computer (see page 20).

Switch to the room computer’s input
source (see page 24).

Ensure that SMART Product Drivers is
installed and that the SMART Board
service is running.*

The interactive flat panel comes with two pens with erasers attached.

The interactive flat panel’s bottom frame includes magnetic holders for the pens. Removing a pen

from the holders activates it, and you can use it to draw or erase digital ink.

A CAUTION

When you return the pen to the magnetic holder, make sure it’'s centered inits holder to keep it

from falling and being damaged.

4This only applies when a computer is connected to the interactive flat panel's computer connectors.

7 smarttech.com/kb/170814
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Presence detection sensor

The interactive flat panel has a presence
detection sensor on its bottom frame that
can detect people up to 16' (5 m) away
when the interactive flat panelisin
Standby mode.

When the sensor detects people in the
room, the interactive flat panel turns on.
Touching the screen activates the
interactive flat panel. If the room is empty
for a specified period, the

interactive flat panel returns to Standby
mode.

« See Cleaning the presence detection sensor on page 34 for more information.

« If presence detectionis enabled, move inrange of the presence detection sensor. See

Proximity in Setup menu options (support.smarttech.com/docs/hardware/kapp/kapp-

ig/en/installing-and-maintaining/using-the-osd-menu/default.cshtml).

If presence detection is enabled, move in range of the presence detection sensor, see

Appendix A: Using the on-screen display menu on page 43.

Speakers

The interactive flat panel includes two 10 W integrated side-firing speakers.

You can connect external speakers if desired (see Connecting external speakers on page 22).

USB receptacle

You can connect a USB drive or device to the USB Type-A
receptacle on the bottom-left corner of the
interactive flat panel, and then open and save files to the

USB devices.

8 smarttech.com/kb/170814
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Accessory slot
You can install the AM30 appliance in the accessory slot located on the back of the
interactive flat panel to take advantage of SMART kapp iQ functionality.

OR

You can install a mini-computer that meets the requirements defined in the specifications.

If you have a SMART Board 8055i-G5-SMP or 8065i-G5-SMP interactive flat panel, you can
install the I/0 extension module in the accessory slot. When installed, the /0O extension module
enables you to connect a computer to the interactive flat panel using USB and HDMI® cables
(see SMART Board 8055i-G5-SMP and 8065i-G5-SMP connector panel on page 17).

A CAUTION

The accessory slot’s maximum available poweris 60 W. The slot is not a limited power source.
To reduce the risk of fire, make sure that accessories connecting to the slot satisfy the fire
enclosure requirements of IEC 60950-1.

About SMART software

To take full advantage of the SMART Board 8000i-G5-SMP series interactive flat panel’s features,
install the following SMART software on computers connected to the interactive flat panel. Go to
SMART Downloads
(smarttech.com/en/Home+Page/Support/Browse+Support/Download+Software).

Software Description

SMART Product Drivers SMART Product Drivers enables connected computers to detect
input from the interactive flat panel.

SMART Ink™ SMART Ink enables you to write and draw in digital ink over
applications, files, folders, websites and any other open window on
your computer. When you write outside the open windows on your
computer, a SMART Ink Note appears, and you can write inside the
note.

When you open an application that has its own ink tools, you can
use the application’s ink tools to write in the content.

9 smarttech.com/kb/170814
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Software Description

SMART Meeting Pro® The room edition of SMART Meeting Pro software is designed for
software use with the interactive flat panel in a meeting room.

The personal edition is designed for use on user computers.

You can write or draw on a digital whiteboard, present content by
sharing your desktop and connect and use integrated conferencing
software to collaborate with local or remote participants.

Resources for administrators

In addition to this guide, SMART provides a variety of other resources for administrators.

SMART Meeting Pro software installation documentation

The interactive flat panel comes with one SMART Meeting Pro software room license to install on
the room computer and 25 SMART Meeting Pro software personal licenses to install on users’
computers.

To install SMART Meeting Pro software, refer to the SMART Meeting Pro software system
administrator’s guide (smarttech.com/kb/170518).

Training
The SMART training website (smarttech.com/training) includes an extensive library of training
resources you can consult as you learn how to set up and maintain the interactive flat panel.

Support center and knowledge base
The Support center (smarttech.com/support) contains a library of documents, including this guide,
and a knowledge base that you can search when troubleshooting issues.

Resources for others

SMART provides resources for decision makers, installers and users as well as administrators.

Resources for decision makers
Decision makers can refer to the specifications for detailed information about the
interactive flat panels.

Model Specifications

SBID8055i-G5-SMP smarttech.com/kb/170815
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SBID8065i-G5-SMP smarttech.com/kb/170841
SBID8065i-G5-SMP-V2 smarttech.com/kb/171095
SBID8075i-G5-SMP smarttech.com/kb/171029

Resources for installers
Installers can refer to the installation instructions included with the interactive flat panel when
installing the product. PDF versions of these installation instructions are available for download.

SBID8055i-G5-SMP smarttech.com/kb/170836
SBID8065i-G5-SMP

SBID8065i-G5-SMP-V2 smarttech.com/kb/171107
SBID8075i-G5-SMP smarttech.com/kb/170996

Installers should also refer to Considerations for non-standard installations
(smarttech.com/kb/171035).

Resources for users

Users can refer to the SMART Meeting Pro software Help for information about using the software
with the interactive flat panel. To open the Help, users can select Help > Contents in Whiteboard
mode.
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Chapter 2

Mounting the interactive flat panel

Before mounting the interactive flat panel

Mounting multiple interactive flat panels

Mounting the interactive flat panel vertically ... ... . i
Choosing @ loCation ... .
Choosing a height L

Mounting the SMART Board 8000i-G5-SMP series interactive flat panel requires a team of
professional installers.

The following information is for installers. Installers should read this information along with the
installation instructions included with the interactive flat panel before they mount the
interactive flat panel.

A WARNING

Improper mounting of the interactive flat panel can result in injury and product damage.

Before mounting the interactive flat panel

Remember the following before mounting the interactive flat panel:

« Review the environmental requirements in the interactive flat panel’s specifications.

« Save all product packaging so that it’s available if you need to transport the
interactive flat panel. If the original packaging isn’t available, you can purchase new
packaging from your authorized SMART reseller (smarttech.com/where).

13 smarttech.com/kb/170814
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14

« Referto local building codes to ensure the wall can support the weight of the

interactive flat panel (specified in the following table) and mounting equipment.

SBID8055i-G5-SMP 107 Ib. (48.4 kg)
SBID8065i-G5-SMP 138 |b. (62.4 kg)
SBID8065i-G5-SMP-V2 134 1b. (60.9 kg)
SBID8075i-G5-SMP 185 Ib. (84 kqg)

Use a standard VESA mounting plate (not included) to mount the interactive flat panel on a
wall.

Use M8 screws to fasten the wall bracket.

Screw length 20 mm +xmm < M8 <45 mm + x mm

where xis the combined thickness of the wall bracket and washer
Fasten force 97.36-177.01in-Ib. (11-20 N-m)

A CAUTION

Do not over-tighten the screws.

4" NOTE

SMART recommends M8 x 30 mm mounting screws for standard installations where the
total wall mount bracket and washer thickness is less than 7 mm.

Because the receptacles might not be easily accessible after the installers mount the
interactive flat panel, consider connecting cables for power, computers and other devices
while the interactive flat panelis still in its packaging (see Chapter 3: Connecting power and
devices on page 17).

Before turning on the interactive flat panel for the first time, clean the camera windows and
reflective tape following the instructions in Cleaning the camera windows and reflective tape
on page 33.

smarttech.com/kb/170814
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Mounting the interactive flat panel vertically

The interactive flat panel is designed for vertical mounting (90° relative to the
floor plus or minus 5° for tolerance). SMART doesn’t support mounting the
interactive flat panel at other angles.

Mounting multiple interactive flat panels

SMART recommends that you mount no more than three interactive flat panels side by side.

If you mount multiple interactive flat panels side by side, install them as shown in the following
diagram. This ensures the interactive flat panels’ cameras don’t interfere with each other.

___ 1/4"(0.6cm)] | 1/4" (0.6cm) 1/4"(0.6¢m) | 11/4" (0.6cm) —

{1 /N ] 0 /N1 \

Choosing a location

Consider the following when choosing a location for the interactive flat panel:

« Do notinstall the interactive flat panel in a location where a door or gate could hit it.

« Do notinstall the interactive flat panel in an area where it will be subjected to strong vibrations
ordust.

« Choose alocation that’s far from bright light sources, such as windows and strong overhead
lighting. Infrared (IR) lighting can cause issues with the performance of the cameras and can
lead to unintentional or missed touches.

« Do notinstall the interactive flat panel near where the mains power supply enters the building.
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« Ensure adequate ventilation or provide air conditioning around the interactive flat panel so
that heat can flow away from the unit and the mounting equipment.

« If youmount the interactive flat panel in a recessed area, leave at least 4" (10 cm) of space
between the interactive flat panel and the recessed walls to enable ventilation and cooling.

Choosing a height

Consider the general height of the user community (4

when you choose the height for the
interactive flat panel.

SMART recommends mounting the

interactive flat panel so that its top is 6' 5" (1.9 m)

from the floor.
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Connecting power and devices

SMART Board 8055i-G5-SMP and 8065i-G5-SMP connectorpanel ... ... .. .. . ... 17
SMART Board 8065i-G5-SMP-V2 and 8075i-G5-SMP connectorpanel ... .. ... . ... ... ........ 18
ConNNECtiNg POW T il 19
Connecting the room COMPULET L 20
Connecting cablesfora guest laptop ... ..o oo 21
Connecting external sSpeakers ... . 22

After mounting the SMART Board 8000i-G5-SMP series but before setting it up, you need to
connect it to power and devices.

SMART Board 8055i-G5-SMP and 8065i-G5-SMP
connector panel

The following diagram and table present the connectors on SMART Board 8055i-G5-SMP and
8065i-G5-SMP interactive flat panels and the I/O extension module (if installed):

AW =

(@]
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No. Connector

Interactive flat panel

1 RS-232

2 USB Micro-A
3 Stereo 3.5 mm
4 USB Type-B

5 HDMI|®

1/0 extension module

6 Stereo 3.5 mm
7 HDMI
8 USB Type-B

Connects to

Room control system

IN/A]

External speakers

Room computer or guest

laptop (touch)

Room computer or guest

laptop (video)

IN/A]

Room computer (video)

Room computer (touch)

Notes

See page 53.
This connector is a service port.
See page 22.
See page 20.

The HDMI cable should be HDMI
1.4 compliant and no longer than
16' 5" (5 m).

See page 20 for more
information.

This connector is not available
for SMART interactive products.

See page 20.
See page 20.

SMART Board 8065i-G5-SMP-V2 and

8075i-G5-SMP connector panel

The following diagram and table present the connectors on SMART Board 8065i-G5-SMP-V2 and
8075i-G5-SMP interactive flat panels:

18 smarttech.com/kb/170814
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No. Connector

1 USB Micro-A

2 RS-232

3 Stereo 3.5 mm
4 USB Type-B

5 DisplayPort

6 USB Type-B

7 HDMI

8 USB Type-B

9 HDMI

Connects to

[N/A]

Room control system
External speakers

Guest laptop (touch)

Guest laptop (video)

Guest laptop (touch)

Guest laptop (video)

Room computer (touch)

Room computer (video)

Connecting power

Connect the supplied power cable from the AC
power inlet on the bottom of the interactive flat panel

to a power outlet.

19 smarttech.com/kb/170814
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See page 22.
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information.
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information.
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1.4 compliant and no longer than
16' 5" (5 m).

See page 21formore
information.

See page 20.

The HDMI cable should be HDMI
1.4 compliant and no longer than
16' 5" (5 m).

See page 20 for more
information.



http://www.smarttech.com/kb/170814

CHAPTER3
CONNECTING POWER AND DEVICES

4 NOTE

Refer to the interactive flat panel’s specifications for power requirements and power
consumption information (see Resources for decision makers on page 10).

Connecting the room computer

How you connect the room computer to the interactive flat panel depends on the model of
interactive flat panel and what is installed in the accessory slot:

Models In the accessory slot Connections

SBID8055i-G5-SMP Nothing
SBID8065i-G5-SMP

SBID8055i-G5 I/O extension module
SBID8065i-G5

SBID8065i-G5-SMP-V2 [N/A]
SBIDS075i-SMP-G5

a7/ AN

TR = e T .
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Connecting cables for a guest laptop

Depending on the model and whether the room computeris connected to the interactive flat
panel or the I/O extension module, there may be one ortwo additional sets of connectors available
for guest laptops.

| a—\~]

SBID8055i-G5-SMP SBID8065i-G5-SMP-V2
SBID8065i-G5-SMP SBID8075i-G5-SMP

You can install cables that enable users to connect a guest laptop to the interactive flat panel from
another location in the room, such as on a conference table. By installing these cables, you make
use of connectors that might not be accessible when the interactive flat panel is wall-mounted.

Connect USB and HDMI or DisplayPort cables to the appropriate connectors on the
interactive flat panel. You can then run the cables across floors or behind walls to the conference
table.

A WARNING

Ensure that any cables that cross the floor to the interactive flat panel are properly bundled and
marked to avoid a trip hazard.
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Connecting external speakers

The interactive flat panel includes two 10 W speakers. However, you can connect external active
speakers using the stereo 3.5 mm connector.

:
r
: o mm | [
0
]
’
Eﬂ
SBID8055i-G5-SMP SBID8065i-G5-SMP-V2
SBID8065i-G5-SMP SBID8075i-G5-SMP
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Turning on the interactive flat panel and room computer for the firsttime ... ... ... . ... ....... 23
Installing SMART Meeting Pro software ... .. 24
Running the SMART Connection Wizard ... ... i 24
Switching between input SOUrCes il 24
Displaying multiple iNput SOUICES .. ... . e e 25

After mounting the SMART Board 8000i-G5-SMP series interactive flat panel (see Chapter 2:
Mounting the interactive flat panel on page 13) and connecting it and the room computer (see
Chapter 3: Connecting power and devices on page 17), you can turn on and set up both devices.

Turning on the interactive flat panel and
room computer for the first time

Turn on the interactive flat panel and room computer after mounting the interactive flat panel and
connecting it to the room computer.

P To turn on the interactive flat panel and room computer for the first time
1. Turn onthe room computer.

2. Turnonthe interactive flat panel by flicking the power switch beside the AC power inlet to the
ON (I) position.
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Installing SMART Meeting Pro software

Download and install SMART Meeting Pro software on any connected computers to take full
advantage of the interactive flat panel’s features.

For more information, refer to the system administrator’s guide for your computer’s operating
system (see SMART Meeting Pro software installation documentation on page 10).

Running the SMART Connection Wizard

After installing SMART Meeting Pro software, run the SMART Connection Wizard to calibrate and
orient the interactive flat panel.

—=> IMPORTANT

You must calibrate the interactive flat panel before using it.

To run the SMART Connection Wizard

1. Connect a keyboard and mouse to the room computer.

2. Accessthe SMART Connection Wizard by opening SMART Settings (see Opening SMART
Settings on page 30).

3. Click Connection Wizard.
The SMART Connection Wizard appears.

4. Selectthe interactive flat panel from the list of connected SMART interactive products, and

then click Next.
5. Select Product is being set up for the first time, and then click Next.

6. Follow the on-screen instructions to calibrate and orient the interactive flat panel for the

first time.

Switching between input sources

You can switch between input sources at any time by pressing the Input Select button E onthe

front control panel:
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Option Input source

HDMI1 Room computer if the room computeris connected to the
interactive flat panel

OR
Guest laptop if a guest laptop is connected to the interactive flat panel

HDMI2 Guest laptop (SMART Board 8065i-G5-SMP-V2 and 8075i-G5-SMP
interactive flat panels only)

DisplayPort Guest laptop (SMART Board 8065i-G5-SMP-V2 and 8075i-G5-SMP
interactive flat panels only)

OPS/HDMI Room computer if the I/O extension module is installed in the accessory slot
and the room computer is connected to the I/O extension module

OPS/DisplayPort  Optional mini-computer if installed in the accessory slot (SMART Board
8065i-G5-SMP-V2 and 8075i-G5-SMP interactive flat panels only)

Displaying multiple input sources
You can display up to four input sources on a SMART Board 8065i-G5-V2 or 8075i-G5 interactive
flat panel using the on-screen display menu (see Multi-Window menu options on page 50).

If you use this feature, be aware that SMART doesn’t support touch while multiple input sources are
displayed on the interactive flat panel.
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This chapter describes common maintenance procedures for the interactive flat panel.

Resetting the interactive flat panel

You can reset the SMART Board 8000i-G5-SMP series interactive flat panel using the front control
panel.

27 smarttech.com/kb/170814


http://www.smarttech.com/kb/170814

CHAPTERS
MAINTAINING THE INTERACTIVE FLAT PANEL

D Toreset the interactive flat panel

1. Press the Standby button v) on the front control panel.

A message appears on the screen, prompting you to either press the button again to enter
Standby mode or press and hold the button to reset the interactive flat panel.

2. Press and hold the Standby button J until the screen turns black.

The interactive flat panel resets, and then your computer’s logon screen or desktop appears
on the interactive flat panel.

Updating firmware and software
SMART periodically releases updates to the SMART Board 8000i-G5-SMP series interactive flat
panel’s firmware as well as to SMART software. Install these updates for the best experience.

Updating firmware

The interactive flat panel uses firmware on its processor. Updates to SMART software could
include a firmware update in the form of a downloaded firmware executable file. When the
interactive flat panel detects this executable file, you're prompted to run the file to update the

firmware.

A CAUTION
« Only a system administrator should update interactive flat panel firmware.

« Only one interactive flat panel can be connected to the computer during the firmware

update.
« Do not disconnect the interactive flat panel from your computer during the firmware update.
« Do nottouch the interactive flat panel screen or input button during the firmware update.

o Do not turn off your computer or the interactive flat panel during the firmware update.

) To update firmware

1. Make sure the interactive flat panel is connected to a computer on which you’ve downloaded

the firmware update.
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2. Browse to and start the firmware updater at the following location:

Operating system Location

Windows (32-bit) C:\Program Files\SMART Technologies\SMART Product Drivers\
SMARTFirmwareUpdater.exe

Windows (64-bit) C:\Program Files (x86)\SMART Technologies\SMART Product
Drivers\
SMARTFirmwareUpdater.exe

3. Follow the on-screen instructions using the computer's mouse and keyboard. Don’t touch the
interactive flat panel screen.

4. Selectthe check boxforthe SMART product you want to update, and then click Next.
A progress bar appears.

5. When the installation is complete, calibrate the interactive flat panel (see Calibrating the
interactive flat panel on page 31).

Updating SMART Meeting Pro software

SMART Product Update (SPU)is included in SMART Meeting Pro software. SPU periodically
checks for updates to SMART Meeting Pro software and other SMART software posted on the
SMART website. You can configure SPU to prompt users to install updates or to install updates

automatically.

For more information, refer to the SMART Meeting Pro software system administrator’s guide (see
SMART Meeting Pro software installation documentation on page 10).

o Ifyoudidn’tinstall SPU, you can download updates to SMART Meeting Pro software and
other SMART software from smarttech.com/downloads.

« Evenifyouinstalled SPU, you should visit smarttech.com from time to time to learn about
major new releases of SMART Meeting Pro software and other SMART software.

Using SMART Settings

Use SMART Settings to configure the SMART software on computers connected to the
SMART Board 8000i-G5-SMP series interactive flat panel.
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Opening SMART Settings

D To open SMART Settings on Windows 7 operating system
Select Start > All Programs > SMART Technologies > SMART Tools > SMART Settings.

SMART Settings appears.

D To open SMART Settings on Windows 8 operating system
1. Openthe Apps screen.
2. Select SMART Technologies > SMART Settings.

SMART Settings appears.

D To open SMART Settings on Windows 10 operating system
1. Select Start > All apps.
2. Select SMART Technologies > SMART Settings.

SMART Settings appears.

Orienting the interactive flat panel
If the interactive flat panel is connected to a computer and the pointer appears a distance from the
actual contact when you touch the screen, orient the interactive flat panel.

You can use your finger or a pen to orient the interactive flat panel.

) To orient the interactive flat panel when connected to a computer
1. Open SMART Settings (see Opening SMART Settings above).
2. Press Orient.

3. Pressthe red targets as they appear. Hold your finger or the tip of the pen at the center of
each target, and then lift the pen or finger. When you lift the pen or finger, the target moves to

the next orientation point.

9 IMPORTANT

Hold the pen at a right angle to the screen.
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4. Continue until you've pressed all the targets.

5.

The orientation window closes.

If orientation doesn’t correct inaccurate touch, calibrate the interactive flat panel (see
Calibrating the interactive flat panel below).

Calibrating the interactive flat panel

Digital cameras in the corners of the interactive flat panel track the position of the pens, eraser and
your finger on the interactive surface, and then send the information to the SMART software on
connected computers, which interprets this information as mouse clicks, digital ink or an eraserin
the appropriate location. Calibration determines the position and angles of the cameras to
accurately identify the location of touches on the interactive flat panel.

—> IMPORTANT

If an error message appears while you calibrate the interactive flat panel, contact SMART

Support (smarttech.com/contactsupport).

) To calibrate the interactive flat panel when connected to a computer

1.

2.

31

Open SMART Settings (see Opening SMART Settings on the previous page).
Press SMART Hardware Settings.

If more than one SMART product is connected to your computer, select the

interactive flat panel.

Select Advanced Settings from the drop-down list.

Press Calibrate, and then follow the on-screen instructions.
The calibration screen appears. This can take a few moments.

Press the red target with the tip of a pen. Hold the tip at the center of the target until the target
turns green, and then lift the pen.

The target moves to the next location.

You can calibrate a target again by pressing the LEFT ARROW key on your keyboard.
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7. Continue pressing targets until the second calibration screen and a grid appears.

An example appears briefly to demonstrate how to draw across the screen to calibrate the

interactive surface.

8. Use a pento draw a spiral horizontally across the grid. As you draw, the ink is blue. As you
complete each square, the square becomes green.

9. When all the squares are green, a progress bar appears.

When the progress bar is full, the interactive flat panel displays the message
Calibration successful.

—> IMPORTANT

Wait until the calibration screen indicates that the interactive flat panel is operating correctly

before proceeding.

10. Orient the interactive flat panel (see Orienting the interactive flat panel on page 30).

Cleaning and maintaining the
interactive flat panel

With proper cleaning and maintenance, the SMART Board 8000i-G5-SMP series interactive flat

panel will provide years of use.

Checking the interactive flat panel installation
Inspect the interactive flat panel installation frequently to ensure that it remains securely installed.

« Check the mounting location for signs of damage or weakness that can occur over time.

« Check forloose screws, gaps, distortions or other issues that could occur with the mounting

hardware.

If you find anissue, contact a professional installer.
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Cleaning the screen
Follow these instructions to clean the interactive flat panel screen without damaging its anti-glare
coating or other product components.

A CAUTION

« Do not use permanent or dry-erase markers on the screen. If dry-erase markers are used on
the screen, remove the ink as soon as possible with a lint-free, non-abrasive cloth.

« Do notrub the screen with a dense or rough material.
« Do not apply pressure to the screen.

« Do not use cleaning solution or glass cleaner on the interactive flat panel screen, because
they can deteriorate or discolor the screen.

« Avoid touching the reflective tape between the screen and the frame, and ensure that this
strip stays dry. Damage to this strip affects touch interactivity.

) Toclean the screen
1. Turn off any connected computers.
2. Pressthe Standby button v) on the front control panel twice.
3. Turnthe interactive flat panel off by flicking the power switch beside the AC power inlet.

4. Wipe the screen with a lint-free, non-abrasive cloth.

Cleaning the camera windows and reflective tape

The interactive flat panel’s DVIT technology uses four cameras in the corners of the frame and the
reflective material between the screen and the frame. Dust buildup on the camera windows or
reflective tape can impair touch performance.

Inspect these areas regularly for dust, and clean them if any obvious buildup has occurred.

A CAUTION

o Dust buildup on the camera windows and reflective tape will degrade touch performance.
SMART recommends that you inspect the camera windows and reflective tape for buildup
and clean weekly.

« Do not use compressed air to clean the camera windows or borders.

« Do not use water, chemicals or cleaning agents.

33 smarttech.com/kb/170814


http://www.smarttech.com/kb/170814

CHAPTERS
MAINTAINING THE INTERACTIVE FLAT PANEL

« Applying too much pressure when cleaning the tape or cameras can damage the tape and

cause performance issues or errors.

P To clean the camera windows and reflective tape

1. Using a clean lint-free cloth, gently wipe the camera windows in the top corners and the
reflective tape along the top of the interactive flat panel screen.

2. Gently wipe the reflective tape along the sides of the interactive flat panel screen.

3. Gently wipe the camera windows in the bottom corners and the reflective strip across the
bottom of the interactive flat panel screen.

Cleaning the presence detection sensor
The interactive flat panel has a presence detection sensor on its bottom frame.

Inspect the sensor regularly for dust and gently wipe it using a clean lint-free cloth if buildup has
occurred.

A CAUTION

Do not use compressed air, water, chemical agents or cleaning agents to clean the sensor.

Maintaining ventilation
The interactive flat panel requires proper ventilation. Dust buildup in the ventilation holes
compromises cooling and can lead to product failure.

« Clean accessible ventilation holes monthly with a dry cloth.

« Use avacuum cleaner with a narrow hose end fitting to clear the back ventilation holes
regularly. You might have to remove the interactive flat panel from the wall. For more
information on removing the interactive flat panel, see Removing and transporting the
interactive flat panel on the facing page.

A CAUTION

Avoid setting up or using the interactive flat panel in an area with excessive levels of dust,
humidity or smoke.
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Preventing condensation
The interactive flat panel screen contains layers of glass that can collect condensation, especially
in the following conditions:

« Temperature extremes with high humidity

« Rapid changes in humidity, which can occur when you operate the product near water (such as
a pool, kettle or air conditioner ventilator)

« Direct exposure to sunlight

D To evaporate condensation from the interactive flat panel
1. Remove the humidity source from the interactive flat panel, if possible.
2. Turn off the interactive flat panel.
3. Remove any moisture from the interactive flat panel with a smooth, dry cloth.

4. Leave the interactive flat panel turned off for 48 hours.

Maintaining pens

To prevent damage to the interactive flat panel’s anti-glare coating, replace a pen if its nib
becomes worn. You can purchase replacement pens from the Store for SMART Parts

(see smarttech.com/Support/PartsStore).

Removing and transporting the
interactive flat panel

On occasion, you might need to remove the SMART Board 8000i-G5-SMP series interactive flat
panel from its current location and transport it to another location.

Removing the interactive flat panel
To remove the interactive flat panel safely, use two or more professional installers.

A WARNING

« Do not attempt to move the interactive flat panel by yourself. The interactive flat panel is
very heavy.

« Do not move the interactive flat panel by connecting a rope or wire to the handles on the
back. The interactive flat panel can fall and cause injury and product damage.
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=> IMPORTANT

Follow the instructions included with the floor stand or mounting hardware.

P Toremove the interactive flat panel

1.

2.

3.

4.

7.

Turn off any connected computers.

Press the Standby button v) on the interactive flat panel’s front control panel twice.
Turn off the interactive flat panel by flicking the power switch beside the AC powerinlet.
Remove all accessible cables and connectors.

Remove any modules from the accessory slot.

Lift the interactive flat panel from its mounting location.

A WARNING

Do not place the interactive flat panel on a sloping or unstable cart, stand or table, because
the interactive flat panel could fall, resulting in injury and severe product damage.

A CAUTION

Do not leave the interactive flat panel face up, face down or upside down for an extended
period, because it could cause permanent damage to the screen.

Remove the mounting brackets.

Transporting the interactive flat panel
Save your original packaging so that you can repack the interactive flat panel with as much of the

original packaging as possible. This packaging was designed to provide the best possible

protection against shock and vibration. If the original packaging isn’t available, you can purchase

the same packaging directly from your authorized SMART reseller (smarttech.com/where).

A CAUTION

Transport the interactive flat panel only in original or replaced packaging. Transporting the

interactive flat panel without correct packaging can lead to product damage and voids the

warranty.

36

smarttech.com/kb/170814


http://www.smarttech.com/kb/170814
http://www.smarttech.com/where

Chapter 6
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Resolving issues with the interactive flat panel .. ... . ... 37
Using the indicator light to resolve commonissues ... ... ... oo 37
Resolving presence detection issUesS ... .. 37
ResoIViNg iIMage ISSUES ... .o . 38
Resolving toUCh ISSUES .. . 39
Resolving connected computerissues ... ... . 39
Locating the interactive flat panel serial number ... ... ... 2y

Using SMART software t0 resoIve 1SSUES . ... 41
Using the SMART Connection Wizard ... . .. a4
Using SMART DiagnostiCs ... 42

This chapter helps you solve issues that can occur with the interactive flat panel.

Resolving issues with the interactive flat panel

To resolve issues with the SMART Board 8000i-G5-SMP series interactive flat panel, review the
following information. If the issues persist or aren’t covered in the following information, contact
SMART Support (smarttech.com/contactsupport).

Using the indicator light to resolve common issues

The Standby button on the front control panel also functions as an indicator light. You can use the
indicator light to resolve common issues with the interactive flat panel. For more information, see
Front control panel on page 6.

Resolving presence detection issues
Use the following table to resolve presence detectionissues:

Symptom Cause Solution
The interactive flat panelisn’t Presence detection isn’t Enable presence detection. See Proximity in Setup
turning on. enabled. menu options (

support.smarttech.com/docs/hardware/kapp/kapp-
ig/en/installing-and-maintaining/using-the-osd-
menu/default.cshtml).
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Symptom

The interactive flat panelis turning

on when people aren’t present.

Cause Solution

There isn’t enough difference Reduce the room temperature.

between the room temperature
and human body temperature.

You aren’twithin 16' (5 m) ofthe  Move closer to the interactive flat panel or make

interactive flat panel. bigger motions.

Thereis glass, acrylic or similar ~ Remove the material.

material between you and the
interactive flat panel.

Sunlightis hitting the Close any blinds or shades.

interactive flat panel.

Thereis glass, acrylic or similar ~ Remove the material.

material between you and the
interactive flat panel.

There’s a sudden temperature ~ Remove the source of major temperature

change in the room (for fluctuation.
example, humidifier emission,

air conditioning or heating

system).

Sunlightis hitting the Close any blinds or shades.

interactive flat panel.

Resolving image issues
Use the following table to resolve image issues:

Symptom

There is a persistentimage on the

screen.
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Cause Solution

You or another user pressedandheld  Unfreeze the screen by doing one of
the Mute button on the front control the following:

panel of the SMART Board 8065i-

Press and hold the Mute button.

G5-SMP-V2 or 8075i-G5-SMP « Changeinputsources.
interactive flat panel, causing the « Disconnectthe currently selected
screen to freeze. input source.

« Exit Standby mode.
Animage was displayed for too long. Turn off the interactive flat paneland

leave it turned off for as long as the
image was on the screen.

Set up screen savers on any connected
computers to prevent persistent
images.
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Resolving touch issues

Use the following table to resolve touch issues:

Symptom

When you touch the screen, the pointer
appears in the wrong place.

An area of the screen doesn’trespond
to touch, or when you draw digital ink,
the lines are broken.

You can interact with screen elements
by touching them, but you can’t write or
draw using the pens.

Cause

Solution

You aren’ttouching the screen ataright See Touching and drawing on your

angle.

The interactive flat panelisn’t oriented.

Something is blocking the cameras.

Somethingis in the reflective tape
channel.

Your finger or penis skipping as you
draw. This is most common on the
upstroke.

Bright lights are interfering with the
cameras.

The cameras require calibration,
possibly because of a temperature
change in the room.

If you’re sharing content from your

computer or mobile device to the board

using Wireless Screen Share, you’re
unable to ineract with the screen using
your fingers or pens.

The cameras require calibration,
possibly because of a temperature
change in the room.

Resolving connected computer issues
Use the following table to resolve connected computerissues:

Symptom

The connected computer’s display is
too large, too smallor doesn’t
completelyfillthe screen.
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Cause

The connected computer’s video
resolution settings don’t match the
interactive flat panel’s native resolution.

SMART Board interactive whiteboard is
inaccurate
(kb.smarttech.com/?q=13976).

Orientthe interactive flat panel (see
page 30).

Ensure nothing is taped to the screen.

Remove items from the reflective tape
channel.

Use consistent pressure while drawing
digitalink.

Close blinds or shades or dim all
halogen lights and LEDs.

Calibrate the interactive flat panel (see
page 31).

Calibrate the interactive flat panel (see
page 31).

Solution

Setthe computer’s video resolution to
3840 x 2160 at 30 Hz. (If the connected
computer can’t support this resolution,
consider 1920 x1080 at60 Hz as an
alternative.)
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Symptom

The connected computer’s screen
resolution is correct, butthe image is

surrounded by black bars.

The connected computer’s display is

unstable or unfocused.

The SMART Board icon [*] doesn’t

appear.

Touch interactivity is slow.
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Cause

The connected computer’s video card
is underscanning the image.

The video cable is of poor quality.

You're using two connected video
cables.

The video connection is loose.

The video cable is of poor quality.

You’re using two connected video
cables.

The connected computer’s video
display card is defective.

SMART Product Drivers isn’tinstalled.

SMART Product Drivers isn’t running.

The connected computer is running too
many applications.

The connected computer doesn’t meet
SMART requirements.

You haven’tused a USB 2.0 cable to
connect the interactive flat panelto the
computer.

Solution

Turn off or adjustthe
overscan/underscan feature in the
video card driver software untilthe
image fits the screen resolution. Refer
to the computer’s video card Help for
more information.

Select the 4K UHD option from the
video card driver’s advanced menu (if
available).

Replace the video cable with a better
quality video cable.

Replace the two cables with one longer
cable.

OR

Move the computer so that it’s within a
single cable length of the
interactive flat panel.

Secure the video cable to both your
computer and the interactive flat panel.

Replace the video cable with a better
quality video cable.

Replace the two cables with one longer
cable.

OR

Move the computer so thatit’s within a
single cable length of the
interactive flat panel.

Connect a different computer to the
interactive flat panel. If this improves
the image quality, consider replacing
the video card in the original computer.

Download and install SMART Product
Drivers from
smarttech.com/downloads.

Start SMART Product Drivers following
the stepsin the Help.

Close some open applications.

Upgrade the computer or replace it
with another computer that meets
system requirements.

Use a USB 2.0 cable and ensure it's
connected to the correct USB
receptacle (see page 20).
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Symptom Cause Solution

There’s no sound when you play an The connected computer’s playback Ensure the connected computer’s
audio file. device isn't set correctly. playback device is set as the

interactive flat panel (see the
connected computer’s documentation).

The SMART Board 8055i-G5-SMP or Ensure the interactive flat panel's audio
8065i-G5-SMP interactive flat panel’'s inputis set as the computer’s audio
audio inputisn’t set correctly. connector (see page 46).

The connected computer is muted. Turn off the mute setting.

The connected computer’s volume is Turn up the volume on the computer.

too low.

The interactive flat panelis muted. Turn off the mute setting using the front
control panel.

The interactive flat panel’s volume is Turn up the volume using the front

too low. control panel.

Locating the interactive flat panel serial number
If you ever need to contact SMART Support for help with your SMART kapp iQ board, you'll be
asked for board’s serial number. The serial number is located in three Aplaces:

« The on-screen display menu (see Serial Number on page 47)

« The on-screen display menu. See Serial Number in the About menu options
(support.smarttech.com/docs/hardware/kapp/kapp-ig/en/installing-and-maintaining/using-the-

osd-menu/default.cshtml).
« Underneath the bottom frame

« Onthe back of the interactive flat panel

Using SMART software to resolve issues

You can resolve some issues with the SMART Board 8000i-G5-SMP series interactive flat panel
using the SMART Connection Wizard and SMART Diagnostics.

Using the SMART Connection Wizard

You can resolve a variety of issues using the SMART Connection Wizard found in SMART Settings.

D To usethe SMART Connection Wizard

1. Access the SMART Connection Wizard by opening SMART Settings (see Opening SMART
Settings on page 30).
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Press Connection Wizard.
The SMART Connection Wizard appears.

Select the interactive flat panel from the list of connected SMART interactive products, and
then press Next.

Select the option that best describes the issue you’re encountering, and follow the on-screen
instructions.

Using SMART Diagnostics

If you touch the interactive flat panel’s surface and nothing happens, if there is no digital ink, or if

the ink appears in some locations and not in others, use SMART Diagnostics to help identify and

resolve these issues.

—> IMPORTANT

Do not change diagnostic settings unless asked to do so by SMART Support.

) To check camera views

1.

2.

42

Open SMART Settings (see Opening SMART Settings on page 30).

Select About Software and Product Support > Tools > Diagnostics.

SMART Diagnostics opens.

Select View > SPNL-6000/SBID8000-G5 Bar.

The group box appears.

Press View.

The camera view screen appears.

Click Get image to display the four camera views. This could take a few moments.

If one of the camera views doesn’t appear, the camera is blocked or can’t locate the
reflective tape on the interactive flat panel’s inner frame.

You can compare the camera view to examples of normal camera views.

Check the camera lens and ensure that nothing is blocking its view and that nothing is affixed
to the interactive surface.
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Using the on-screen display menu

Changing settings in the on-screen display menu ... .. ... 44
SMART Board 8055i-G5-SMP and 8065i-G5-SMP on-screendisplaymenu ......................... 44
PiCtUre MeNU OPTIONS . 44
Sound MenU OPLIONS .. 45
OSD MeNU OPtiONS . L 46
Setup MeNU OPtIONS .. 46
ADOUL MENU OPTIONS ... e 47
SMART Board 8065i-G5-SMP-V2 and 8075i-G5-SMP on-screendisplay menu ._..._............... 48
Picture menu OptioNS .l 48
Sound MeNU OPtIONS .. L 49
OS D MenNU 0P IONS il 49
SetUp MeNU OPtIONS .. 49
Multi-Window menu OptioNS .. .. 50
AboUt MeNU OPtIONS .. 51

You can access the on-screen display menu using the menu control panel located on the side of
the SMART Board 8000i-G5-SMP series interactive flat panel.

1 MENU
2 SET
3 (Up]

43 smarttech.com/kb/170814


http://www.smarttech.com/kb/170814

APPENDIX A
USING THE ON-SCREEN DISPLAY MENU

4 [Down]
5 [Left]
6 [Right]

Changing settings in the on-screen display menu

) To change settings in the on-screen display menu
1. Press the MENU button on the menu control panel.
The on-screen display menu appears.
2. Pressthe up and down arrows to highlight a menu, and then press SET.
3. Pressthe up and down arrows to highlight a menu option.
4. Press the left and right arrows to change the menu option’s setting.
OR

Press the right arrow to open the menu option’s submenu. (Repeat steps 3 and 4 to change
settings in the submenu.)

5. Press MENU until the on-screen menu closes.

SMART Board 8055i-G5-SMP and 8065i-G5-SMP
on-screen display menu

Picture menu options

Option Values Function Notes
» Picture Mode Standard Sets the picture mode Select User to customize
User brightness, contrast, sharpness

. and other Picture options.
Dynamic

Select one of the other values to set
brightness, contrast, sharpness
and other Picture options to default

values.
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Option Values Function Notes
® Brightness 0-100 Sets the overall brightness of the You can modify this option only if
image and background you select User in Picture Mode.
® Contrast 0-100 Sets the difference in brightness You can modify this option only if

between the lightest and darkest you select User in Picture Mode.
parts of theimage.

® BlackLevel 0-100 Sets the level of brightness in the You can modify this option only if
darkest parts of the image you select User in Picture Mode.
® Color 0-100 Sets the image color depth You can modify this option only if

you select User in Picture Mode.

® Sharpness 0-100 Sets the image sharpness You can modify this option only if
you select User in Picture Mode.

» Color temperature Normal Sets the color temperature Select User to customize the
Warm amountofred, green andblue in
Vs the image.
Select one of the other values to set
Cool

the amount of red, green and blue
inthe image to default values.

® Red 0-100 Setsthe amount ofred intheimage You can modify this option only if
you select User in Color
Temperature.
® Green 0-100 Sets the amount of greenin the You can modify this option only if
image you select User in Color
Temperature.
® Blue 0-100 Sets the amount of blue in the You can modify this option only if
image you select User in Color
Temperature.
® Movie Mode Off Sets the brightness, contrast,black  [N/A]
Low level, color and sharpness for
Middle movie watching
High
® Picture Reset [N/A] Resets all options in the Picture [N/A]

menu to their default values

Sound menu options

Option Values Function Notes

» Sound Mode

® Treble L50-R50 Sets the high frequency sound [N/A]
® Bass L50-R50 Sets the low frequency sound [N/A]
> EQ
® 120 Hz 0-100 Sets the sound equalization at [N/A]
120 Hz

45 smarttech.com/kb/170814


http://www.smarttech.com/kb/170814

APPENDIX A
USING THE ON-SCREEN DISPLAY MENU

Option Values
® 500 Hz 0-100
® 12kHz 0-100
® 75kHz 0-100
® 12kHz 0-100
® Balance L50-R50
OR
-50-50
® Audio Input [Depends on the
currentvideo
input]
® SoundReset [N/A]

OSD menu options

Option Values
® lLanguage [Languages]
® OSD Turn Off Off
5seconds
10 seconds
15 seconds
® OSD Reset [N/A]
Setup menu options
Option Values
® Power Save On
Off
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Function Notes
Sets the sound equalization at [N/A]
500 Hz

Sets the sound equalization at [N/A]
1.2kHz

Sets the sound equalization at [N/A]
75kHz

Sets the sound equalization at [N/A]
12 kHz

Balances the left and right volume [N/A]

Sets the audio input source If HDMl is the current video input,
the available values are HDMI and

USB.

If OPS/HDMI is the current video
input, the available values are
OPS Digitaland USB.

Resets all options in the Sound [N/A]
menu to their default values
Function Notes
Sets the on-screen display [N/A]

menu’s language

Sets the time of inactivity before [N/A]
the on-screen display menu
turns off

Resets all options in the OSD [N/A]
menu to their default values
Function Notes

When Power Save mode is enabled
and there is no video input, the
interactive flat panel displays

No Signalfor 25 seconds before
turning off.

Enables or disables Power Save
mode
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Option Values
® Monitor ID 1-100
® FBC Control On
Off
> Proximity On
Off
® Re-enable Time 1Min.-10Min.
® Auto Power Off 15Min.—240Min.
® Videoinput detect On
Off
® Lync®Room Reset [N/A]
® Setup Reset [N/A]
® Factory Reset [N/A]

About menu options

Option Values
® ModelNumber [N/A]
® Serial Number [N/A]

47

Scalar firmware version [N/A]

Touch firmware version [N/A]

OPS Information [N/A]

smarttech.com/kb/170814

Function Notes
Specifies a unique ID for the [N/A]
interactive flat panel

Enables or disables the front [N/A]

control panel

Enables or disables presence [N/A]
detection
Sets how long the [N/A]

interactive flat panel waits before
detecting motion again

Sets how long the [N/A]

interactive flat panel waits before

turning off

Enables or disables video input With video input detection, the
detection interactive flat panel displays the

default video input when there are
no computers or other devices
connected.

Video input detection is usefulin
scenarios where a user connects a
laptop to the interactive flat panel
for a meeting and forgets to return
to the default video input after
disconnecting the laptop.

Resets options in allmenus to their ~ [N/A]
default values (for a SMART Room
System™ with Skype® for Business)

Restores the setup settings to their ~ [N/A]
defaultvalue

Resets options in allmenus to their ~ [N/A]
defaultvalues

Function Notes

Displays the interactive flat panel's  [N/A]
model number

Displays the interactive flat panel's  [N/A]
serialnumber

Displays the interactive flat panel's  [N/A]
scalar frmware version

Displays the interactive flat panel's  [N/A]
touch firmware version

Displays whether a module is [N/A]
installed in the accessory slot
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SMART Board 8065i-G5-SMP-V2 and
8075i-G5-SMP on-screen display menu

Picture menu options

Option Values Function Notes
» Picture Mode Standard Sets the picture mode Select User to customize
User brightness, contrast, sharpness
D ) and other Picture options.
ynamic
Selectone of the other values to set
brightness, contrast, sharpness
and other Picture options to default
values.
® Brightness 0-100 Sets the overall brightness of the You can modify this option only if
image and background you select User in Picture Mode.
® Contrast 0-100 Sets the difference in brightness Y ou can modify this option only if
between the lightest and darkest you select User in Picture Mode.
parts of the image.
® BlackLevel 0-100 Sets the level of brightness in the You can modify this option only if
darkest parts of the image you select User in Picture Mode.
® Color 0-100 Sets the image color depth Y ou can modify this option only if
you select User in Picture Mode.
® Sharpness 0-100 Sets the image sharpness You can modify this option only if
you select User in Picture Mode.
» Color temperature Normal Sets the color temperature Select User to customize the

Warm amountofred,green and bluein

User the image.

Cool Select one of the other values to set
the amount of red, green and blue
in the image to default values.

® Red 0-100 Setsthe amount ofred in theimage You can modify this option only if
you select User in Color
Temperature.
® Green 0-100 Sets the amount of greenin the You can modify this option only if
image you select User in Color
Temperature.
® Blue 0-100 Sets the amount of blue in the You can modify this option only if
image you select User in Color
Temperature.
® Local Dimming On Enables or disables local dimming This option is applicable to only

Off mode. SMART Board 8075i-G5-SMP

interactive flat panels.
® Picture Reset [N/A] Resets all options in the Picture [N/A]

menu to their default values
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Sound menu options

Option Values Function Notes
® Volume 0-100 Sets the volume [N/A]
® Balance L50-R50 Balances the leftand rightvolume  [N/A]
OR
-50-50
® Sound Reset [N/A] Resets all options in the Sound [N/A]

menu to their default values

OSD menu options

Option Values Function Notes
® Language [Languages] Sets the on-screen display menu’s  [N/A]
language
® OSD Turn Off Off Sets the time of inactivity before the  [N/A]
5seconds on-screen display menu turns off
10 seconds
15 seconds
® OSD Reset [N/A] Resets all options in the OSDmenu  [N/A]

to their default values

Setup menu options

Option Values Function Notes
® Power Save On Enables or disables Power Save When Power Save mode is enabled
Off mode and there is no video input, the

interactive flat panel displays
No Signalfor 25 seconds before

turning off.
® Monitor ID 1-100 Specifies a unique ID for the [N/A]
interactive flat panel
® FBC Control On Enables or disables the front [N/A]
Off control panel
® Wake to Touch On Enables or disables the ability to [N/A]
Off wake the interactive flat panels by
touching the screen.
> Proximity On Enables or disables presence [N/A]
Off detection
® Re-enable Time 1Min.—10Min. Sets how long the [N/A]

interactive flat panel waits before
detecting motion again
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Option Values Function Notes
® Auto Power Off 15Min.—240Min.  Sets how long the [N/A]
interactive flat panel waits before
turning off
® Video input detect Off Specifies the default video input With video input detection, the
OPS/HDMI source when video input detection interactive flat panel displays the
OPS/DisplayPort is enabled selected video input when therfe
are no computers or other devices
connected.

Video input detection is usefulin
scenarios where a user connects a
laptop to the interactive flat panel
for a meeting and forgets to return
to the default video input after
disconnecting the laptop.

® Setup Reset [N/A] Restores the setup settings to their ~ [N/A]
defaultvalue

® Factory Reset [N/A] Resets options in allmenus to their ~ [N/A]
defaultvalues

Multi-Window menu options

Option Values Function Notes

® Multi-Window Mode Off Sets the number of video inputs If you use this feature, be aware
Dual displayed on the that SMART doesn’t support touch
Quad interactive flat panel’'s screen to while multiple input sources are

one (Off), two (Dual) or four (Quad) displayed on the
interactive flat panel.

® Audio Input Window1 Sets the audio input source when You can modify this option only if
Window?2 multiple video inputs are displayed  you select Dual or Quad in
Window3 Multi-Windows Mode.
Window4
® Window1 [Depends onthe Selectthe video input for the first You can modify this option only if
model] window you select Dual or Quad in
Multi-Windows Mode.
® Window2 [Depends onthe Selectthe video inputfor the Y ou can modify this option only if
model] second window you select Dual or Quad in
Multi-Windows Mode.
indow: ependsonthe Selectthe video input for the thir ou can modify this option only i
® Window3 [Dr d he Sel he videoi for the third Y dify thi i ly if
model] window you select Quad in Multi-Windows
Mode.
® Window4 [Depends onthe Selectthe video input for the fourth  You can modify this option only if
model] window you select Quad in Multi-Windows
Mode.
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About menu options

Option Values Function Notes

® ModelNumber [N/A] Displays the interactive flat panel's  [N/A]
model number

® Serial Number [N/A] Displays the interactive flat panel's  [N/A]
serialnumber

® Scalar firmware version [N/A] Displays the interactive flat panel's  [N/A]
scalar frmware version

® Touch firmware version [N/A] Displays the interactive flat panel's  [N/A]
touch firmware version

® OPSInformation [N/A] Displays whether a module is [N/A]
installed in the accessory slot
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You can connect a computer to the room control input on the SMART Board 8000i-G5-SMP series
interactive flat panel to remotely select video inputs, turn the interactive flat panel on or off and get
information about the interactive flat panel’s current settings, such as contrast and power state.

Connecting a computer to the
interactive flat panel

To connect a computer to the interactive flat panel

Connect an RS-232 cable from the computer’s serial output to the room control input on the
connector panel.
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SBID8055i-G5-SMP SBID8065i-G5-SMP-V2
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—> IMPORTANT

Do not use a null modem cable. Use only a standard RS-232 cable.

Configuring the computer’s serial interface
settings

Configure the computer’s serial interface before sending commands to the interactive flat panel.

) To configure the computer’s serial interface
1. Turn onthe interactive flat panel.

2. Turn onthe computer, and then start the serial communications program or terminal emulation
program.

3. Activate local echo.

4. Configure the serial interface settings using the following values, and then press ENTER.

Baud rate 19200
Data length 8
Parity bit None
Stop bit 1

A command prompt (>) appears on the following line, and the interactive flat panel can now
accept commands from the computer.

If no message appears or an error message appears, the serial interface isn’'t configured
correctly. Repeat steps 3 and 4.
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Power modes

The interactive flat panel has three power modes:
« On
« PowerSave
« Standby

All commands are available when the interactive flat panel is on. Some commands are available

when the interactive flat panel is in Standby mode.

Commands and responses

To access interactive flat panel information or to adjust interactive flat panel settings using the
room control system, type commands after the command prompt (>), and then wait for the
response from the interactive flat panel.

>get contrast
contrast=>55

If you type a command that the room control system doesn’t recognize, you receive an invalid

command response.

In the example below, the userincluded an extra space in the contrast command.

INCORRECT

>set con trast=65
invalid cmd=set con trast=65

o« Use ASCIl formatted commands.
« Commands aren’t case-sensitive.
o Review each entry carefully before you press ENTER.

« Don’t send another command until you receive the response and the next command
prompt.
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P To view alist of available commands

Type ? at the command prompt, and then press ENTER.

) Toidentify the current value of a setting

Use the get command.

This example shows how to get the contrast level:

>get contrast
contrast=55

) To identify the current value of a setting for a specific video input

Use the get command and specify the video input.

This example shows how to get the contrast level for the HDMI video input:

>get contrast hdmil
contrast hdmil=65

You must connect the video input to the interactive flat panel to identify a value forit, but

the video input doesn’t need to be in use.

) To assign avalue to a setting

Use the set command.

This example sets the contrast level to 65:

>set contrast=65
contrast=65

) To assign a value to a setting for a specific video input

Use the set command and specify the video input.

This example sets the contrast level to 70 for the HDMI video input:

>set contrast hdmil=70
contrast hdmil=70
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4 NOTE

You must connect the video input to the interactive flat panel to set a value for it, but the

video input doesn’t need to be in use.

) Toincrease or decrease the value of a setting

Use the set command to increase or decrease the value by a designated number.

This example increases the contrast level by 5:

>set contrast +5
contrast=70

This example decreases the contrast level by 15:

>set contrast -15
contrast=55

SMART Board 8055i-G5-SMP and 8065i-G5-SMP

command inventory
This section contains the commands for SMART Board 8055i-G5-SMP and 8065i-G5-SMP

interactive flat panels.

Power state

Use the following commands to identify power state settings.

Command

getintpowerstate

get powerstate
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Response

intpowerstate=/Value]

powerstate=/Value]

Possible values Standby
mode

on Yes
standby

dpms

novideo

confirm

proximitywait

welcome

on Yes
off
standby
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Use the following commands to assign power state settings.

Command Possible values Response Standby
mode
set powerstate [Value] =on powerstate=/Value] Yes
=off
=standby
Source

Use the following commands to identify source settings.

Command Response Possible values Standby
mode
getinput input=/Value] hdmit Yes
ops/hdmi2
get videoinputs videoinputs=/Value] hdmit Yes
ops/hdmi2

Use the following commands to assign source settings.

Command Possible values Response Standby
mode
setinput/Value] =hdmi1 input=/Value] Yes
=ops/hdmi2
=next
Video
Use the following commands to identify video settings.
Command Response Possible values Standby
mode
getdisplaymode displaymode=/Value] standard No
user
dynamic
get contrast contrast=Value] 0-100 No
get brightness brightness=/Value] 0-100 No
gettint tint=/Value] 0-100 No
getsharpness sharpness=/Value] 0-100 No
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Command

get colortemp

getred
getgreen
getblue

get blacklevel

Use the following commands to assign video settings.

Command

Response

colortemp=/Value]

red=/Value]
green=Value]
blue=/Value]

blacklevel=/Value]

Possible values

Possible values

normal
warm
cool

user
0-100
0-100
0-100

0-100

Response

Standby
mode

No

No
No
No

No

Standby
mode

set displaymode [Value]

set contrast/Value]

set brightness [Value]

settint/Value]

setsharpness[Value]

set colortemp [Value]

setred/[Value]

setgreen[Value]

set blue [Value]
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=standard
=user
=dynamic

+[Incremental value]
-[Incremental value]
=0-100

+[Incremental value]
-[Incremental value]
=0-100

+[Incremental value]
-[Incremental value]
=0-100

+[Incremental value]
-[Incremental value]
=0-100

=normal
=warm
=cool

=user

+[Incremental value]
-[Incremental value]
=0-100

+[Incremental value]
-[Incremental value]
=0-100

+[Incremental value]
-[Incremental value]
=0-100

displaymode=/Value]

contrast=/Value]

brightness=/Value]

tint=/Value]

sharpness=/Value]

colortemp=/Value]

red=/Value]

green=Value]

blue=/Value]

No

No

No

No

No

No

No

No

No
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Command Possible values Response Standby
mode
set blacklevel[Value] +[Incremental value] blacklevel=Value] No
-[Incremental value]
=0-100
set picturereset/[Value] =yes pictureresets/Value] No
Audio

Use the following commands to identify audio settings.

Command Response Possible values Standby
mode
getvolume volume=/Value] 0-100 No
get mute mute=/Value] on No
off
getaudioinput audioinput=/Value] usbaudio No
HDMI
OPSdigital
gettreble treble=/Value] 0-100 No
getbass bass=/Value] 0-100 No
getaudioeq120 audioeq120=/Value] 0-100 No
getaudioeq500 audioeq500=/Value] 0-100 No
getaudioeq1200 audioeq1200=/Value] 0-100 No
getaudioeq7500 audioeq7500=Value] 0-100 No
getaudioeq12k audioeq12k=Value] 0-100 No
getbalance balance=/Value] 0-100 No

Use the following commands to assign audio settings.

Command Possible values Response Standby
mode
setvolume [Value] +[Incremental value] volume=/Value] No
-[Incremental value]
=0-100
setmute [Value] =on mute=/Value] No
=off
setaudioinput/Value] =usbaudio audioinput=/Value] No
=HDMI
=OPSDigital
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Command Possible values Response Standby
mode
settreble [Value] +[Incremental value] treble=[Value] No
-[Incremental value]
=0-100
set bass[Value] +[Incremental value] bass=Value] No
-[Incremental value]
=0-100
setaudioeq120 [Value] =0-100 audioeq120=/Value] No
setaudioeq500 [Value] =0-100 audioeq500=/Value] No
setaudioeq1200 [Value] =0-100 audioeq1200=Value] No
setaudioeq7500 [Value] =0-100 audioeq7500=Value] No
setaudioeq12k/Value] =0-100 audioeq12k=/Value] No
setbalance [Value] +[Incremental value] balance=/Value] No
-[Incremental value]
=0-100
setsoundreset/Value] =yes soundreset=/Value] No

System information
Use the following commands to identify system information settings.

Command Response Possible values Standby
mode

get autopoweroff autopoweroff=Value] 15-240 No

get fwverscr fwverscr=[Value] [Scalar version frmware number]  Yes

get fwvertouch fwvertouch=/Value] [Touch controller frmware version  Yes
number]

getserialtouch serialtouch=Value] [Touch controller serialnumber] No

get opsinfo opsinfo=/Value] OPS No
NO OPS
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Command Response Possible values Standby
mode

getlanguage! language=/Value] English No

Arabic
Danish
German
Spanish
Finnish
French
Hebrew
Italian
Dutch
Norwegian
Portuguese
Russian
Swedish
Turkish

Chinese_sim

getmodelnum modelnum=/Value] [Modelnumber] No
getserialnum serialnum=/Value] [Serialnumber] No
get proximityinstalled proximityinstalled=/Value] yes
no
get proximity proximity=/Value] on Yes
off
get proximityreenable proximityreenable=/Value] 1-10 Yes
get proximitydetected proximitydetected=/Value] yes No
no
get monitorid monitorid=/Value] 1-100 No

Use the following commands to assign system information settings.

Command Possible values Response Standby
mode
set autopoweroff[Value] +[Incremental value] autopoweroff=Value] No
-[Incremental value]
=15-240
set factoryreset[Value] =yes factoryreset=/Value] Yes

Languages for the on-screen display menu only
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Command Possible values

setlanguage [Value]? =English
=Arabic
=Danish
=German
=Spanish
=Finnish
=French
=Hebrew
=ltalian
=Dutch
=Norwegian
=Portuguese
=Russian
=Swedish
=Turkish
=Chinese_sim

set proximity [Value] =on
=off

set proximityreenable [Value] =1-10

set monitorid [Value] +[Incremental value]
-[Incremental value]
=1-100

setlyncroom [Value] =reset

settouchdetected [Value] =yes

Response

language=/Value]

proximity=/Value]

proximityreenable=/Value]

monitorid=/Value]

lyncroom=/Value]

touchdetected=/Value]

SMART Board 8065i-G5-SMP-V2 and
8075i-G5-SMP command inventory

This section contains the commands for SMART Board 8065i-G5-SMP-V2 and 8075i-G5-SMP

interactive flat panels.

2| anguages for the on-screen display menu only
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No

Yes

Yes
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Power state
Use the following commands to identify power state settings.

Command Response Possible values Standby
mode

getintpowerstate intpowerstate=/Value] on Yes
standby
dpms
novideo
confirm
proximitywait
welcome

get powerstate powerstate=/Value] on Yes
off
standby

Use the following commands to assign power state settings.

Command Possible values Response Standby
mode
set powerstate [Value] =on powerstate=/Value] Yes
=off
=standby
Source

Use the following commands to identify source settings.

Command Response Possible values Standby
mode

getinput input=Value] hdmit Yes
hdmi2
displayport
ops/hdmi
ops/displayport

get videoinputs videoinputs=/Value] hdmit Yes
hdmi2
displayport
ops/hdmi
ops/displayport

get videoinputdetect videoinputdetect=/Value] ops/hdmi No
ops/displayport
off
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Use the following commands to assign source settings.

Command Possible values Response
setinput/Value] =hdmi1 input=/Value]
=hdmi2
=displayport
=ops/hdmi
=ops/displayport
=next
set videoinputdetect[Value] =ops/hdmi videoinputdetect=Value]
=ops/displayport
=off
Video
Use the following commands to identify video settings.
Command Response Possible values
getdisplaymode displaymode=/Value] standard
user
dynamic
get contrast contrast=/Value] 0-100
get brightness brightness=/Value] 0-100
gettint tint=/Value] 0-100
getsharpness sharpness=/Value] 0-100
get colortemp colortemp=/Value] normal
warm
cool
user
getred red=[Value] 0-100
getgreen green=Value] 0-100
getblue blue=/Value] 0-100
getblacklevel blacklevel=Value] 0-100
getlocaldimming3 localdimming=/Value] on
off

3SMART Board 8075i-G5-SMP interactive flat panels only
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Standby
mode

Yes

No

Standby
mode

No

No
No
No
No

No

No
No
No
No

No
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Use the following commands to assign video settings.

Command

set displaymode [Value]

set contrast/Value]

set brightness [Value]

settint/Value]

setsharpness[Value]

set colortemp [Value]

setred[Value]

setgreen[Value]

set blue [Value]

set blacklevel[Value]

setlocaldimming [Value]*

Possible values

=standard
=user

=dynamic

+[Incremental value]
-[Incremental value]
=0-100

+[Incremental value]
-[Incremental value]
=0-100

+[Incremental value]
-[Incremental value]
=0-100

+[Incremental value]
-[Incremental value]
=0-100

=normal
=warm
=cool

=user

+[Incremental value]
-[Incremental value]
=0-100

+[Incremental value]
-[Incremental value]
=0-100

+[Incremental value]
-[Incremental value]
=0-100

+[Incremental value]
-[Incremental value]
=0-100

=on
=off

4SMART Board 8075i-G5-SMP interactive flat panels only
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Response

displaymode=/Value]

contrast=/Value]

brightness=/Value]

tint=/Value]

sharpness=/Value]

colortemp=/Value]

red={Value]

green=/Value]

blue=/Value]

blacklevel=/Value]

localdimming=/Value]

Standby
mode

No

No
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Audio
Use the following commands to identify audio settings.
Command Response Possible values Standby
mode
getvolume volume=/Value] 0-100 No
get mute mute=/Value] on No
off
get balance balance=/Value] 0-100 No

Use the following commands to assign audio settings.

Command Possible values Response Standby
mode
setvolume [Value] +[Incremental value] volume=/Value] No
-[Incremental value]
=0-100
set mute [Value] =on mute=/Value] No
=off
setbalance [Value] +[Incremental value] balance=/Value] No
-[Incremental value]
=0-100
setsoundreset/Value] =yes soundreset=/Value] No
Multi-Window
Use the following commands to identify Multi-Window settings.
Command Response Possible values Standby
mode
getmw mw=/Value] off No
dual
quad
get mwaudioinput mwaudioinput=/Value] window1 No
window?2
window3
window4
get mwwindowlinput mwwindowlinput=/Value] hdmi1 No
hdmi2
displayport
opshdmi
opshdmidisplayport
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Command Response Possible values Standby
mode

get mwwindow2input mwwindow2input=/Value] hdmit No
hdmi2
displayport
opshdmi
opshdmidisplayport

get mwwindow3input mwwindow3input=/Value] hdmit No
hdmi2
displayport
opshdmi
opshdmidisplayport

get mwwindow4input mwwindow4input=/Value] hdmit No
hdmi2
displayport
opshdmi
opshdmidisplayport

Use the following commands to assign Multi-Window settings.

Command Possible values Response Standby
mode

setmw [Value] =off mw=/Value] No
=dual
=quad

set mwaudioinput/Value] =window1 mwaudioinput=/Value] No
=window?2
=window3

=window4

set mwwindowlinput/Value] =hdmi1 mwwindowlinput=/Value] No
=hdmi2
=displayport
=opshdmi
=opshdmidisplayport

set mwwindow?2input/Value] =hdmil mwwindow?2input=/Value] No
=hdmi2
=displayport
=opshdmi
=opshdmidisplayport

set mwwindow3input[Value] =hdmi1 mwwindow3input=/Value] No
=hdmi2
=displayport
=opshdmi
=opshdmidisplayport
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Command Possible values Response Standby
mode
set mwwindow4input[Value] =hdmi1 mwwindow4input=/Value] No
=hdmi2
=displayport
=opshdmi
=opshdmidisplayport

System information
Use the following commands to identify system information settings.

Command Response Possible values Standby
mode

get autopoweroff autopoweroff=[Value] 15-240 No
get fwverscr fwverscr=[Value] [Scalar version frmware number]  Yes

get fwvertouch fwvertouch=/Value] [Touch controller frmware version  Yes
number]

get serialtouch serialtouch=/Value] [Touch controller serial number] No

get opsinfo opsinfo=/Value] OPS No
NO OPS

getusb usb=/Value] hdmit No
hdmi2
displayport
ops

getlanguage® language=Value] English No
Arabic
Danish
German
Spanish
Finnish
French
Hebrew
Italian
Dutch
Norwegian
Portuguese
Russian
Swedish
Turkish
Chinese_sim

SLanguages for the on-screen display menu only

69 smarttech.com/kb/170814


http://www.smarttech.com/kb/170814

APPENDIX B
REMOTELY MANAGING THE INTERACTIVE FLAT PANEL

Command Response Possible values Standby
mode

get modelnum modelnum=/Value] [Modelnumber] No

getserialnum serialnum=/Value] [Serialnumber] No

get proximityinstalled proximityinstalled=/Value] yes
no

get proximity proximity=/Value] on Yes
off

get proximityreenable proximityreenable=/Value] 1-10 Yes

get proximitydetected proximitydetected=/Value] yes No
no

get monitorid monitorid=/Value] 1-100 No

get powersave powersave=/Value] on No
off

getfbc foc=/Value] on No
off

get waketotouch waketotouch=/Value] on No
off

Use the following commands to assign system information settings.

Comm. Possible values Response Standby
mode
set autopoweroff[Value] +[Incremental value] autopoweroff=[Value] No
-[Incremental value]
=15-240
setfactoryreset/Value] =yes factoryreset=[Value] Yes
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Command Possible values

setlanguage [Value]® =English
=Arabic
=Danish
=German
=Spanish
=Finnish
=French
=Hebrew
=ltalian
=Dutch
=Norwegian
=Portuguese
=Russian
=Swedish
=Turkish
=Chinese_sim

set proximity [Value] =on
=off
set proximityreenable [Value] =1-10
set monitorid [Value] +[Incremental value]
-[Incremental value]
=1-100
setlyncroom [Value] =reset
settouchdetected [Value] =yes
set powersave [Value] =on
=off
setfbc/Value] =on
=off
set waketotouch [Value] =on
=off

6Languages for the on-screen display menu only
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Response

language=/Value]

proximity=/Value]

proximityreenable=/Value]

monitorid=/Value]

lyncroom=/Value]
touchdetected=/Value]

powersave=/Value]

foc=/Value]

waketotouch=/Value]

Standby
mode

No

Yes

Yes
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Appendix C

Hardware environmental
compliance

SMART Technologies supports global efforts to ensure that electronic equipment is manufactured,
sold and disposed of in a safe and environmentally friendly manner.

Waste Electrical and Electronic Equipment (WEEE)
Electrical and electronic equipment contain substances that can be harmful to the

environment and to human health. The crossed-out wheeled bin symbol indicates that E
products should be disposed of in the appropriate recycling stream and not as regular

waste.

More information

See smarttech.com/compliance for the materials table.
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A contrast, 45, 48, 58, 65
air conditioning, 16, 35
AM30 appliance, 9

angle (mounting), 15 D

aspectratio, 5 documentation, 10

audio dry-erase markers, 33
about, 3 dust, 15, 33-34

configuring, 45, 49, 60, 67

controlling volume, 6

muting, 6 E
troubleshooting, 41 eraser, 7

B F

balance, audio, 46, 49, 60, 67 factory reset, 47, 50

bass, 45, 60 SMART kapp iQ 55 and 65 boards, 47
black level, 45, 48, 59, 65 firmware updates, 28

brightness, 45, 48, 58, 65 front control panel, 6

C G

calibration, 24, 31 gestures, 3

cameras glass cleaner, 33
about, 5
cleaning, 33

chemicals, 33 H

cleaning hardware installation, 13, 32
camera windows, 33 hardware removal, 35
presence detection sensor, 34 HDMI, 20, 58
reflective tape, 33 height for mounting the interactive flat
screen, 33 panel, 16

colortemperature, 59, 65 humidity, 34-35

computer

connecting, 20

condensation, 35
connector panel, 17 I/O extension module

about, 9
connectors, 17
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installation instructions, 11 R
recessed areas, 16
reflective tape channel, 5, 33

K remote management, 53
knowledge base, 10 reset, 27
room control, 53
|_ RS-232,53
languages, 46, 49, 62, 69
local building codes, 14 S
location for mounting the interactive flat serial number, 41, 47, 51, 61, 69
panel, 15 sharpness, 45, 48, 58, 65

SMART Connection Wizard, 24, 41
SMART Diagnostics, 42

M SMART Ink
M8 screws, 14 about, 9
maintenance, 27 installing, 24
markers, 33 updating, 29
menu control panel, 43 SMART kapp iQ functionality
mounting instructions, 13 about, 3
multitouch capabilities, 3 installing the AM30 appliance for, 9
multiuser sketch support, 3 SMART Meeting Pro software
about, 10
installing, 24
O updating, 29
object awareness, 3 SMART Product Drivers
on-screen display menu, 43 about, 9
orientation, 24, 30 installing, 24
updating, 29
SMART Product Update, 29
P SMART Settings, 30
packaging, 36 smoke, 34
PenlID, 3 software installation, 24
pens software updates, 29
about, 7 speakers
maintaining, 35 built-in, 3, 8, 60, 67
permanent markers, 33 external, 22
power, 15,19, 23,55, 57, 64 specifications, 10
presence detection sensor stand, 36
about, 8 Standby mode, 46, 49, 55, 57, 64
cleaning, 34 sunlight, 35
configuring, 62, 70 Support center, 10

troubleshooting, 37
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updates
firmware, 28
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vacuum cleaners, 34
ventilation, 16, 34
vertical mounting, 15
VESA mounting plate, 14
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WEEE Directives, 73

77 smarttech.com/kb/170814


http://www.smarttech.com/kb/170814

SMART TECHNOLOGIES
smarttech.com/support
smarttech.com/contactsupport

smarttech.com/kb/170814


http://www.smarttech.com/support
http://www.smarttech.com/contactsupport
http://www.smarttech.com/kb/170814

	Cover
	Important information
	Contents
	Chapter 1: Welcome
	About this guide
	About the interactive flat panel
	Models
	Specifications
	Features
	Components
	Screen
	Cameras and reflective tape channel
	Front control panel
	Pens with erasers
	Presence detection sensor
	Speakers
	USB receptacle
	Accessory slot


	About SMART software
	Resources for administrators
	SMART Meeting Pro software installation documentation
	Training
	Support center and knowledge base

	Resources for others
	Resources for decision makers
	Resources for installers
	Resources for users


	Chapter 2: Mounting the interactive flat panel
	Before mounting the interactive flat panel
	Mounting the interactive flat panel vertically
	Mounting multiple interactive flat panels
	Choosing a location
	Choosing a height

	Chapter 3: Connecting power and devices
	SMART Board 8055i‑G5‑SMP and 8065i‑G5‑SMP connector panel
	SMART Board 8065i‑G5‑SMP‑V2 and 8075i‑G5‑SMP connector panel
	Connecting power
	Connecting the room computer
	Connecting cables for a guest laptop
	Connecting external speakers

	Chapter 4: Setting up the interactive flat panel and room computer
	Turning on the interactive flat panel and room computer for the first time
	Installing SMART Meeting Pro software
	Running the SMART Connection Wizard
	Switching between input sources
	Displaying multiple input sources

	Chapter 5: Maintaining the interactive flat panel
	Resetting the interactive flat panel
	Updating firmware and software
	Updating firmware
	Updating SMART Meeting Pro software

	Using SMART Settings
	Opening SMART Settings
	Orienting the interactive flat panel
	Calibrating the interactive flat panel

	Cleaning and maintaining the interactive flat panel
	Checking the interactive flat panel installation
	Cleaning the screen
	Cleaning the camera windows and reflective tape
	Cleaning the presence detection sensor
	Maintaining ventilation
	Preventing condensation
	Maintaining pens

	Removing and transporting the interactive flat panel
	Removing the interactive flat panel
	Transporting the interactive flat panel


	Chapter 6: Troubleshooting
	Resolving issues with the interactive flat panel
	Using the indicator light to resolve common issues
	Resolving presence detection issues
	Resolving image issues
	Resolving touch issues
	Resolving connected computer issues
	Locating the interactive flat panel serial number

	Using SMART software to resolve issues
	Using the SMART Connection Wizard
	Using SMART Diagnostics


	Appendix A: Using the on-screen display menu
	Changing settings in the on-screen display menu
	SMART Board 8055i‑G5‑SMP and 8065i‑G5‑SMP on‑screen display menu
	Picture menu options
	Sound menu options
	OSD menu options
	Setup menu options
	About menu options

	SMART Board 8065i‑G5‑SMP‑V2 and 8075i‑G5‑SMP on‑screen display menu

	Appendix B: Remotely managing the interactive flat panel
	Connecting a computer to the interactive flat panel
	Configuring the computer’s serial interface settings
	Power modes
	Commands and responses
	SMART Board 8055i‑G5‑SMP and 8065i‑G5‑SMP command inventory
	Power state
	Source
	Video
	Audio
	System information

	SMART Board 8065i‑G5‑SMP‑V2 and 8075i‑G5‑SMP command inventory
	Power state
	Source
	Video
	Audio
	Multi-Window
	System information


	Appendix C: Hardware environmental compliance
	Waste Electrical and Electronic Equipment (WEEE)
	More information

	Index

